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System requirements
The following minimum requirements for the PC system apply to the installation and operation of the DriveControlSuite
commissioning software, including the integrated PASmotion component, for configuring the SE6 safety module:

§ Operating system: Windows 10 (32-bit, 64-bit *) or Windows 11 (32-bit, 64-bit *)

§ Processor: Intel Pentium 4 (2 GHz, Dual Core) or equivalent

§ Memory: 2 GB

§ Free disk space on the hard disk: 1 GB

§ Graphics: 1024 × 768 pixel resolution, 65536 colors

§ Font size: 100% (default)

§ Interfaces: 100 Mbps Ethernet (Fast Ethernet, copper)

§ Display of documentation: Adobe Acrobat Reader version 7.1.0 or later**

*) Only DriveControlSuite

**) Only PASmotion
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DriveControlSuite V 6.5-L
This release contains many new features for Predictive Maintenance relating to the load matrix, life performance indicator
and available gear unit types. Additional functions open up new possibilities in type Drive Based applications, while a new
wizard increases commissioning convenience for PROFIdrive applications.

§ Predictive Maintenance
You can expect the following new features for Predictive Maintenance. Information on Predictive Maintenance can be
found in the manual for the respective drive controller as usual, and now in the DS6 online help as well.

• Life performance indicator
The gear ratio and instances where the maximum emergency stop torque M2NOT was exceeded by 90% are now
taken into account for calculating the life performance indicator. Another new feature: the weakest bearing at the
time of calculation is used as a reference (parameter: R120 – R122).

• Maximum service life
Predictive Maintenance now recommends replacing the geared motor once it has been in operation for 100,000 h
or more (operating time: R123). Maximum service life is a separate indicator and is not taken into account when
calculating the life performance indicator.

• Load matrix
The load matrix functions now have their own wizard (wizard: Load matrix). When sending the load matrix, you can
now view a preview of the data, store contact information (name, company, email) and include additional
information or questions via a free text field. If there is no online connection between DriveControlSuite and the
drive controller or if the project contains reverse documentation for the drive controller in question, the buttons
for sending or exporting the load matrix are now inactive. The CSV export of the load matrix has been optimized for
further processing with spreadsheet programs and now includes a language-dependent separator.

• 3D load matrix
A new wizard now visualizes the load matrix data for you in the form of a 3D model that you can freely rotate and
scale (wizard: Load matrix 3D).

• Gear unit selection
Predictive Maintenance now also supports single-type multi-stage gear units and is therefore available for a wide
range of gear unit types, such as C, F, K, KL, S, P, PH, PHQ and PE. Two-speed gearboxes, combined gear units and
KS and KX gear units are currently not supported. In addition, the table for gear unit selection now also contains the
description for the code from the type designation in the bearing design, shaft design and gear unit option
columns.

• Database ID
You can also parameterize the database ID for unique identification of the geared motor during the manual
configuration of Predictive Maintenance now (parameter: R119).

§ Additional functions
The Additional functions wizard has been reworked in all applications and has the following new features.

• Additional counter function
Drive Based applications: The new additional counter function provides you with up to 4 independent counters
with which you can implement smaller automation tasks directly in the drive controller, such as direct or indirect
control of the digital outputs (parameters: N40 – N47; wizard: Counters).

• Additional motor potentiometer function
Drive Based applications: The additional motor potentiometer function has been expanded to include 2 new setting
options in which initialization is triggered with Enable-off (parameter: G368; selection: 4, 5). In addition, the
associated wizard has been arranged more clearly (wizard: Motor potentiometer).

• Additional comparator function
Drive Based applications: In addition to the INT32 and REAL32 comparators, there are now comparators for the
INT8 and INT16 data types, including associated wizards (parameters: C134 – C149; wizards: INT8 comparators,
INT16 comparators).
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• Additional fieldbus-controlled analog output function
CiA 402, Drive Based applications: The additional function for controlling analog outputs via fieldbus can now be
conveniently parameterized with its own wizards, e.g. for the indirect control of an actuator at the analog output
(wizards: Fieldbus-controlled analog output 1, Fieldbus-controlled analog output 2). The additional function is
available for fieldbus communication via EtherCAT, PROFINET and now also for CANopen.

• Additional extended cam control unit function
Drive Based applications: The extended cam control unit is now also available for drive controllers of the SC6 and
SI6 series, as brake connections X2A and X2B have been able to be used as digital outputs if no brake is connected
since DS6 V 6.5-K and associated firmware (prerequisite: F00 = 0: Inactive).

§ PROFIdrive: Drive data
PROFIdrive applications: A new wizard makes commissioning easier thanks to an overview of the drive data (reference
torque, reference speed, maximum speed) that must be transferred unchanged to the TIA Portal (wizard: Drive data).

More new features

§ Graphical programming
You can expect the following new features in the graphical programming.

• Program overview
You can now use the toolbar to display an overview window that shows all blocks on the current level and
highlights the currently visible section of the drawing area with a rectangle. You can use the program overview to
navigate across the drawing area by moving the rectangle for the visible section with the cursor. You can scale the
program overview by dragging the edge of the window larger or smaller with the cursor.

• Parameter description
If you create your own parameters with parameter blocks, you can now create parameter descriptions for them
(Properties window, Description tab). The parameter description is displayed in the both parameter list in the lower
margin area and the graphic editor as a tooltip when you hover over the parameter block with the cursor.

• Signal properties
The properties of signals (signal name, initial value, remanence) are highlighted by symbols on the signal line and
are now easier to distinguish using tooltips.

• Show block in graphic editor
On the Search tab, in the Result area > Structure view, you can now display a hit in the graphic editor by double-
clicking.

§ S1 operating button
SC6, SI6: From hardware version ≥ 50, there is the S1 operating button on the top of the device (nameplate: HW ≥ 50;
parameter: E52[1] ≥ 50). From firmware version V 6.5-L, you can use the S1 operating button to perform actions such
as saving the configuration in non-volatile memory, temporarily deactivating the fan or acknowledging faults. You can
also use the S1 operating button to reset the IP address of the drive controller by holding it down when switching on
until both LEDs are off for the first time (approx. 3 seconds).

§ Scope: Free channel scaling
You can now freely scale both the channel (y-axis) and the time axis (x-axis) in the image editor by entering the desired
scaling factor directly in the respective field and, if necessary, defining the desired unit for the time axis (ns, μs/us, ms,
s). Free channel scaling makes it easier to compare channels or parameters with different scaling, e.g. for comparing
set and actual values.

§ Wake & Shake action
There is now a separate action (parameter: B50) for commutation finding via Wake & Shake when using incremental
encoders in combination with a brake.
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§ Reference retention during device replacement
SC6, SI6: The axis reference is now retained when replacing the device if you proceed as follows: save the configuration
of the drive controller on the SD card for the referenced axis. Replace the drive controller and start the new drive
controller with the SD card inserted. Save the configuration on the new drive controller, remove the SD card and then
restart the drive controller. The axis remains referenced after the device has been replaced and restarted.

§ Brake control, release override
You can now select the source for the brake release override using the new parameter F06. External brake control by a
controller is now carried out using the new parameter F101. For drive controllers of the SC6 and SI6 series, the F92
parameter has been replaced by F108 and F97 by F07, in keeping with the SD6 series. Parameter F07 now serves as an
interface to the firmware for all series.

§ Brake chopper: On limit
SC6, SI6: As with drive controllers of the SD6 series, our system support can now set the on limit of the brake chopper
for the SC6 and SI6 series as well if required: for example, if you are using a linear motor with a 1-phase feed-in and
weak insulation (parameter: A24).

§ Monitor synchronous operation
SC6, SI6: In type Drive Based Synchronous applications, it is now also possible to monitor synchronous operation for
double-axis controllers; information on parameterization can be found in the associated manual in version 03 or later.

§ EtherCAT: ESI file
If you create a new ESI file from DriveControlSuite, it now contains a comment with the DriveControlSuite version with
which the ESI file was originally created. In addition, the object directory has been expanded to include the Torque
slope communication object in accordance with CiA 402 and the ESI file has been updated accordingly (parameter:
A561).

§ Velocity feedforward control
For special applications, the upper limit value for the velocity feedforward control of the position controller has been
increased to 250% (parameter: I25).

Optimizations

§ Fault memory
For greater accuracy and better traceability, the time interval between the triggering of a fault and the recording of the
displayed values for the fault memory has been minimized and behavior when faults occur almost simultaneously has
been optimized (e.g. for 33: Overcurrent and 31: Short/ground).

§ Maximum quick stop duration
The maximum quick stop duration is now only taken into account for Enable-off and not for SS1 or SS2 (parameter:
A39).

§ Motion control panel
The default values of Control panel motion have been adjusted to the default values of Jog control panel (parameters:
K404, K405, K406, K407).

§ Parameter check, messages
The entries in the Parameter check window now have their own Level column, similar to the entries in the Messages
window. Entries in the Messages window can now be filtered by level using new context menus, similar to the entries
in the Parameter check window.

§ PROFIdrive: Torque/force limit
In type PROFIdrive applications with Siemens telegram 105 and Siemens additional telegram 750, limiting the set
torque/set force was optimized: first in the context of torque reduction (MOMRED) and second when using the
TorqueRange block in the TIA Portal with limit values > 200%.

§ CiA 402: Velocity mode (vl)
In CiA 402 applications, the polarity of the axis model is now taken into account in Velocity mode (vl) and you can now
limit the set velocity by the maximum permissible velocity (parameters: I03, I10).
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§ CiA 402: Referencing
In CiA 402 applications, optimizations were made for changing from Homing mode back to Cyclic synchronous position
mode (csp) (referencing method: A586 = 35, 37).

§ Overview of inputs and outputs used
Minor optimizations have been made for the overview of the drive controller connections used (wizard: Terminals >
Inputs/outputs used).

§ Safety configuration: CRC
You can now also view the checksum of the security configuration in the wizard, for example for device replacement
(parameter: S09[2]; wizard: Monitoring: Safety function).

§ Security logger
SC6, SI6: As it is not possible to trace who actually carried out the firmware update when updating the firmware using
an SD card, neither the name of the user nor the PC is logged in this case.

§ Direct connection
SC6, SI6: With an active firewall and fixed IP address for the network adapter, drive controllers now remain visible in
the Add connection dialog box after a direct connection has been established if the IP address is assigned automatically
(address assignment: A166 = 2: DHCP + DS6).

§ Scope: Long-term recordings
The measured value display has been optimized for long-term recordings.

§ Motion block operating mode
In Drive Based applications, motion block operating mode for evaluating Execute signals in case of a direct motion
block start or motion block end control unit was optimized.

§ Wizards: Actions
Wizards for actions such as optimizing the current controller, testing phases, testing windings, etc. no longer time out
after successful execution if a large number of parameters have to be written for the motor.

§ Wizards: Sensitive block diagrams
If you move the cursor over interactive elements such as links in block diagrams, the cursor now changes visually.

§ Virtual master: Quick stop
To make it easier for you to parameterize the quick stop for the virtual master, additional parameters have been added
to the wizard in type Drive Based Synchronous applications (parameters: G56, G57; wizard: Virtual master).

§ Actual current limit
For special applications, the actual current can now be limited to avoid event 33: Overcurrent (parameters: B712,
B713). The new parameters are not functionally implemented in the standard system; corresponding write access to
the graphical programming is required.

§ Control unit temperature
The display for the control unit temperature has been corrected (parameter: E25[1]).

§ Process data mapping
SD6: When you reconfigure the device control and application from Drive Based to CiA 402 or vice versa after the fact,
changes to the process data mapping are now reset and the standard mapping of the respective application is restored.

§ Graphical programming
You can expect the following optimizations in the graphical programming.

• Read parameters
For the smart block for reading parameters, the runtime sequence for using the Element as input option has been
optimized (block: 300005).

• Data type converter
The Datentypkonverter smart block has been optimized by new system block versions for the elegant, low-runtime
conversion of data types, especially with regard to the conversion from DWORD to REAL32 (block: 300004).
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• Parameter blocks
Minor optimizations have been made for the creation of user-defined parameters; for example, the next free
coordinate is now suggested by default instead of P00.

• Constant value
The latest version of the block is now inserted via the Enter constant context menu at the block input 
(block: 8000008).

• Analog input AI3
The scaled value of analog input AI3 is now calculated in real time (block: 100017).

• Standard libraries
Some blocks have been moved from the Parameters standard library to the thematically more appropriate
Applications standard library.

• DS6 block help
The DS6 block help can now also be opened using [F1] for blocks starting from number 800000.
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DriveControlSuite V 6.5-K
This release opens up new opportunities for your PROFIdrive-type applications: New telegrams and technology objects
provide you with functions such as measuring gauges, cams, Dynamic Servo Control and torque reduction. In CiA 402-type
applications, you can now use the Velocity mode.

§ PROFIdrive: telegrams, technology objects
SC6, SI6: For PROFIdrive-type applications, the measuring gauge technology object and a total of 5 new telegrams are
now available to you. They enable the use of functions such as Dynamic Servo Control (DSC) and torque reduction
(MOMRED). In conjunction with the new functions, the wizards and parameters have also been expanded. You will find
more information on the new features in the PROFIdrive operating manual.

• Technology object: measuring gauge
With the help of the measuring gauge function, when the signal of a measuring input is changed by a limit switch,
for example, the drive controller can detect the current actual position of the axis, store it temporarily, and transfer
it to the controller via PROFINET (wizard: Measuring input).

• Technology object: cam, cam track
The cam and cam track technology objects are now available for telegrams 3, 5, 102 and 105, and are configured
via the controller. You will find more information on this in the relevant Siemens function manual.

• Standard telegram 5: Dynamic Servo Control
Standard telegram 5 (set velocity 32 bit with 1 position encoder and Dynamic Servo Control) is available for
application class 4.

• Siemens telegram 102: torque reduction
Siemens telegram 102 (set velocity 32 bit with 1 position encoder and torque reduction) is available for application
classes 1 and 4.

• Siemens telegram 105: MOMRED, DSC
Siemens telegram 105 (set velocity 32 bit with 1 position encoder, torque reduction and Dynamic Servo Control) is
available for application class 4.

• Siemens additional telegram 750
Siemens additional telegram 750 is available for all application classes. It offers additional process data for torque
feedforward control via additive torque and for different torque limits in the positive and negative directions.

• STOBER additional telegram 900
STOBER Additional telegram 900 is available for all application classes and offers additional process data for free
assignment.

§ CiA 402: Velocity mode
In CiA 402-type applications,the Velocity mode operating mode – including a new wizard and updated ESI files – is now
available. You will find more information on the operating mode in the CiA 402 operating manual.

More new features

§ Security logger
SC6, SI6: The newly implemented security logger logs events such as firmware updates and configuration changes for
the drive controller. The events are written to a security log, which you can read in to DriveControlSuite from the drive
controller. Security logs that have already been read out can be viewed both online and offline in DriveControlSuite,

either in the Online functions window via the new  button or in the project tree via the new Security log context
menu.

§ Send configuration: Save values
If you send the configuration from DriveControlSuite to the drive controller, the Save values window now opens
automatically. You can use the new Show window automatically (send configuration) option in the Save values window
to activate/deactivate the behavior as desired.
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§ Direct connection (manual): additional IP addresses
You can add additional IP addresses to the search in the local network if DriveControlSuite does not automatically find
the drive controllers due to the network topology. The drive controllers found are displayed under the Direct
connection tab and are available for establishing the connection. You can reach the Additional IP addresses window via
the context menu of the same name in the Add connection dialog box under the Direct connection tab.

§ Scope: parameter description
If you record the value of a parameter or use a parameter as a trigger source, you can display the associated parameter

description as a tooltip in both the scope image settings and the trigger settings (button: ).

§ Scope: trigger mask
In the trigger settings you can switch the display of the Mask option between hexadecimal and binary display if
required. The mask is displayed with leading zeros according to the data type or data width of the selected parameter.

§ Predictive Maintenance: PE planetary gear unit
2nd generation PE planetary gear units are now available for Predictive Maintenance configuration.

§ Predictive Maintenance: load matrix file name
You can now view the file name of the load matrix for Predictive Maintenance in the wizard (parameter: R106; wizard:
Predictive Maintenance).

§ EtherCAT: station alias
EtherCAT Master (TwinCAT3): Via the controller you can optionally assign a station alias, which is stored in the non-
volatile memory of the drive controller, to each drive controller in the EtherCAT network. As a result, the drive
controller can be connected to any free port within the network and identified (parameter: A254). You will find more
information on this in the EtherCAT operating manual.

§ Motion block end control unit: endless motion commands
The motion block end control unit has been extended such that switching to the subsequent motion block is now
possible even for infinite motion commands. For both finite and infinite motion commands, the motion block end is
reached when the motion core has successfully ended the motion command to be carried out 
(prerequisite: I92 = 1: Active).

§ Encoder simulation: 4096 lines/rev
Simulation at encoder connection X120 is now possible in even higher resolution (parameter: H130 = 7: 2048 i/r).

§ Brake management
SC6, SI6: In preparation for the introduction of the extended safety functions, the Brake management wizard and the
parameters of functional brake management are omitted (parameters: B310, B311, E29, E177, Z772).

§ Brake connection as digital output
SC6, SI6: The new wizard makes it easier to parameterize brake connections X2A or X2B as a digital output if a brake is
not connected (wizard: Terminals > Brake connection as digital output).

Optimizations

§ Quick stop for Enable-off
For Enable-off, a quick stop can now be executed for CiA 402-type applications and PROFIdrive (parameter: A44) as
well.

§ CiA 402: Profile torque mode
For CiA 402-type applications with Profile torque mode there were optimizations for the calculation of the build-up or
reduction of torque/force. The change of torque/force is now maximum by default and the internal calculation is now
done using the load-side reference value for torque/force (parameters: A561, C09).

§ PROFINET: cycle times > 1 ms
Cycle times greater than 1 ms are also now supported correctly for process data communication via PROFINET.



DriveControlSuite V 6.5-K

10

02
/2

02
4 

| 
ID

 4
43

24
0

§ Delete safety configuration
SD6: When the safety configuration in the SE6 safety module is being deleted, the checksum is now set to 0
immediately after a successful action. The drive controller no longer needs to be restarted (action: S33; checksum:
S09).

§ DBCW: material velocity fieldbus scaling
If you transmit the process data in a scaled form, you can now define the number of decimal places for the material
velocity uniformly in Drive Based Center Winder-type applications (parameter: G66).

§ DBS: set reference
In Drive Based Synchronous-type applications, the handshake between drive controller and controller if you set the
reference via the control word of the application (parameter: I210, bit 11) was optimized.

§ TwinCAT 3 function blocks
EtherCAT master (TwinCAT 3): After referencing, the STOBER_MC_Home function block now automatically switches
back to the operating mode before referencing (modes of operation: A541). The STOBER_Backup_Restore function
block was minimally optimized with regard to the interface to CiA 402 and reading out the production number of the
drive controller. You will find more information on the function blocks for TwinCAT 3 in the new TwinCAT 3 manual –
Function blocks for 6th generation drive controllers.

§ SSI encoder: error tolerance
For the evaluation of SSI encoders on X120, the transmission time calculation has been revised to enable higher
sampling rates and thus optimize the error tolerance.

§ EtherCAT time
SD6: The EtherCAT network system time is now no longer displayed as a hexadecimal value but instead, in the date and
time format (parameter: A285; format: YYYY-MM-DD / HH:MM:SS).

§ Autostart: motor control
If the autostart option for the Drive Based device state machine is active, the drive controller now remains in the state
E48 = 0: Self test until the motor control is initialized (Autostart: A34).

DriveControlSuite V 6.5-K SP1
This release is a product update and includes general optimizations.

§ Update project configuration
If you update the project configuration for existing projects to firmware V 6.5-K, the parameter values are now adopted
correctly.

§ Event 47: Tolerance time
The lower limit value for the protective function of event 47: Torque/force-max. limit has been reduced from 1 s to 0 s,
meaning that you can now define very short tolerance times for scope recordings, for example (parameter: U21;
prerequisite: U20 = 2: Warning).
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DriveControlSuite V 6.5-J
As of this release, the control mode for linear motors is now also available for SC6 and SI6 drive controllers. In addition,
Predictive Maintenance has been expanded to include new functions and the DS6 online help has a wealth of new content
for you on the subject of graphical programming.

§ Control mode for linear motors
SC6, SI6: Using the Motor wizard, you can now select the control mode for linear motors (control mode: B20 = 70: SLM
- vector control). For more detailed information on commutation finding, refer to the associated manual of the
respective drive controller.

§ Predictive Maintenance
The following functions are available as of DriveControlSuite V 6.5-J for Predictive Maintenance.

• Geared motor replacement: Reset data
You can now reset the life performance indicator and the load matrix using the respective new wizards
(parameters: R104, R105). For example, if a geared motor was serviced at STOBER or does not have an electronic
nameplate and is replaced by an identical geared motor, the geared motor replacement cannot be recognized by
the serial number, so the data cannot be reset automatically.

• Geared motor replacement: Display
The recommendation for geared motor replacement is now displayed in addition to parameter R100 in the status
byte of the device control and triggers event 91: PM geared motor replacement (status byte: E200[1], bit 5).

• Load matrix: File name
The file name of the load matrix is now displayed in the new parameter R106 (wizard: Predictive Maintenance).

§ DS6 online help
The DS6 online help has been supplemented by numerous new help topics, mainly on the subject of graphical
programming.

• Graphical programming
In the DS6 online help, you now learn how to enable graphical programming in DriveControlSuite. In the help, you
can find descriptions of the program interface of graphical programming, instructions for helpful functions as well
as background knowledge on topics such as block libraries, block types, program structure and run time.

• Script mode: Exit statuses
Calling a command script returns exit statuses, which can be output on a Windows PC using the command prompt,
for example. See the DS6 online help for an overview of the exit statuses and an example of how to extend the
batch file to output the exit statuses.

More new features

§ DriveControlSuite: Release for Windows 11
DriveControlSuite is now also released for the Windows 11 operating system (32 bit, 64 bit).

§ Graphical programming: Block favorites
Favorite frequently used blocks using the new Favorite column, which is now available in the Library and Search tabs. In
the new Block favorites tab, you can quickly access your favorite blocks, manage them in folders or export them.

§ Graphical programming: Replace block
You can now also drag and drop smart blocks to replace them, e.g. with a more current block version or by replacing a
logical And with a logical Or.

§ Electronic nameplate: Scope
As of firmware version V 6.5-J, parameter B28 has been eliminated so that, in addition to the production data, motor
and brake data, the data for the motor adapter, gear unit and geared motor can also be read out without additional
parameterization (prerequisite: B04 = 64: Active). Data related to the axis model is still read out from the electronic
nameplate exclusively via parameter B30.
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§ Configuration dialog: Axes
The configuration dialog now distinguishes between physical and logical axes. The buttons for physical axes are labeled
axis A and axis B (SC6, SI6) and the buttons for logical axes are labeled axis 1 – axis 4 (SD6).

§ DS6 block help
You can now also access the DS6 block help via the menu bar (Help > Help for blocks). In the event that a STOBER
standard block is not described in the selected block version, the block help opens with an orientation guide.

§ EtherCAT: Time stamp frame Rx
Using the new parameter A908, you can now view the time at which an EtherCAT frame is received by the drive
controller.

Optimizations

§ Predictive Maintenance: Transmit load matrix
General optimizations have been made for a smoother transmission of the load matrix directly from DriveControlSuite
(wizard: Predictive Maintenance).

§ Project configuration: Change from CiA 402 to Drive Based
The subsequent change from the CiA 402 device control and application to Drive Based has been optimized with regard
to the available parameters and default values.

§ Jog mode: Interrupt motion block linking
In Drive Based applications in motion block operating mode, motion block linking can now be interrupted by jog mode.

§ Jog mode: Change direction of motion
Changing the direction of motion in jog mode via Jog+ and Jog- has been optimized for limited travel ranges and
software limit switches.

§ Software limit switches: Position window
The position window of the axis now also applies to software limit switches. This means, for example, that the axis can
remain on the software limit switch for any length of time in jog mode (parameter: I22).

§ Software limit switches: Device start-up
During device start-up, undesired behavior used to occur on axes with user-specific scaling and software limit switches.
We have corrected this for you.

§ Drive Based: Velocity specification in real time
In Drive Based applications with velocity, torque/force operating mode, the primary and secondary velocity
specifications are now written in real time (parameter: D40, D41).

§ PROFINET: Process data mapping
SD6: The source parameters for the 3rd part of the transmission channel for TxPZD in the PROFINET network can be
edited with access level 2 once again (parameter: A96).

§ Local operation: Quick stop
SD6: For the control of the device control, the following priorities now also apply to the quick stop: Highest priority is
given to local operation (SD6 operating unit), second highest priority is given to the control panel, lowest priority is
given to control via terminals or fieldbus (controller).

§ Motor temperature sensor
If a One Cable Solution was incorrectly configured as the source for the motor temperature sensor, the setting is
automatically corrected to terminal X2 (parameter: B35).

§ Overheat protection
SI6: Thanks to optimized i2t models, the drive controller is now protected even more reliably against thermal overload.
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DriveControlSuite V 6.5-J SP1
This release is a product update and includes general optimizations.

DriveControlSuite V 6.5-J SP2
This release is a product update and includes general optimizations.

§ Asynchronous motor: Magnetization
In the control modes for asynchronous motors, the axis does not follow the set value or motion command in case of
Enable-on until the magnetization of the motor has been fully built up.

§ EnDat 3 encoder: motor temperature sensor
If a One Cable Solution with tunneled motor temperature sensor serves as a source for the motor temperature, this is
now evaluated correctly (parameter: B35).

DriveControlSuite V 6.5-J SP3
This release is a product update and includes general optimizations.

§ Control unit, power unit: hardware versions
SC6, SI6: Due to new hardware versions for the control unit and power unit of the drive controllers in preparation for
the expanded safety functions, the firmware for the SC6 and SI6 series has been optimized (event 49: Brake). As of
hardware version 50 of the drive controller, you require firmware V 6.5-J SP3 or newer (nameplate: HW ≥ 050;
parameter: E52[1] ≥ 50).
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DriveControlSuite V 6.5-H
As of this release, you can use the new Drive Based Center Winder application to implement winding applications for the
center winder. Numerous other innovations and optimizations in all areas of DriveControlSuite also ensure greater
convenience when creating and maintaining your projects.

§ Drive Based Center Winder application
The Drive Based Center Winder application enables you to realize various winding applications for the center winder
via tensile force control, e.g. winding, unwinding or rewinding materials such as plastic, wire, textiles or paper. The new
Drive Based Center Winder manual supports you in commissioning the application.

• Operating modes: Command and center winder
The command operating mode provides you with a standard set of motion commands based on PLCopen, which is
supplemented by your own motion commands, while the central winder operating mode is reduced to the 30:
MC_Winder motion command, which is essential for winding.

• New wizards and parameters
Numerous new parameters are available for parameterizing the center winder. They are grouped thematically for
you in the new wizards for target-oriented commissioning of the application (parameters: L00 – L656; wizards:
Drive Based Center Winder application).

• Winding diameter: Calculator or sensor
The winding diameter is required for the calculation of the main set values to enable a uniform winding result.
Either use a sensor to measure the winding diameter or have the drive controller calculate the winding diameter.

More new features

§ Restore project file
When you save your project, a backup copy of the project file is now saved on your PC. If the project file is saved
incorrectly, the backup copy can be used to restore the project to the time of the last successful save.

§ Project tree: Description as tooltip
In the configuration dialog, you can store helpful information for the project, a module, a drive controller or a single
axis in the Description field. A new icon in the project tree allows you to immediately see the element for which a
description has been stored. You can display the description as a tooltip by hovering over the icon with the mouse
pointer.

§ Project tree: Axis color code
In the project tree, you can now assign a color code to individual axes in addition to individual drive controllers,
allowing you to maintain a better overview even for double-axis controllers: The color code is displayed in the project
tree and in wizards, the parameter list, the variable parameter list, graphical programming and scope (context menu:
Color code).

§ Wizards: Parameter properties
In the wizards, in addition to the description of a parameter, its properties are now also displayed in the lower margin
area, as was previously the case exclusively in the parameter list.

§ Variable parameter list: Parameter description
In the variable parameter list, there is a new button that allows you to show/hide the description and properties of a
parameter in the lower margin area of the window.

§ Parameter list: Default values
There are 2 new context menus in the parameter list for accepting or overwriting the default value: You can either
overwrite the current value of a parameter with the default value or set it as the new default value. The context menus
are available for all parameters that are stored on the Paramodul.
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§ Manage motor libraries
In the Manage motor libraries window for user-defined motor libraries, you can now delete libraries, groups and
motors, and move or copy motors to other groups or libraries. If you have already created a user-defined motor library,
the Manage motor libraries window can be reached in the menu bar via File > Manage motor libraries and now also
using the wizards (wizard: Motor).

§ Graphical programming: Block descriptions
You can now display the associated descriptions for the graphical programming blocks: Select the required block either
in the library or in the editor and open the associated block description by pressing [F1] on your keyboard.

§ Graphical programming: Check (offline)
You can now also check the graphical programming offline if, for example, a connection to the drive controller is not
possible at the time for spatial reasons. If you have access level 3 for graphical programming, you can find the new
button in the project menu next to the Project configuration button. The result of the check is displayed as an entry in
the Messages window.

§ Graphical programming: Constant value
Block 8000008 Constant value has many new and helpful functions ready for you as of version 1.

• Constant value: Comments
You can now add single-line comments to constants and display them as a tooltip to help you keep track.

• Constant value: Percent scaling
You can now specify integers and floating-point numbers as constants in percent (example: 10%, 2.5%).

• Constant value: Integers
In addition to decimal notation, you can now specify constants in hexadecimal or binary notation by using the hex
or bin postfix (example: 27 = 11011 bin = 1B hex).

• Constant value: Floating-point numbers
If you create a floating-point number as a constant, the entered value is checked and, if necessary, rounded
according to the resolution of the REAL32 data type (example: 12.3456789 → 12.34568).

• Constant value: Selection
Using the properties of the block, you can now select frequently used constants such as 1/60, π, √2 or e.

Optimizations

§ Scope: Recording time & recording details
For scope and multi-axis scope, general optimizations have been made for the display of the remaining recording time
as well as for the display of umlauts in the recording details.

§ Change fieldbus variant: Safety module
SC6, SI6: When changing the fieldbus variant of the firmware, it is now checked which safety module has been
configured for the drive controller. If the SU6 (STO and SS1 via PROFIsafe, requires PROFINET) or SY6 (STO and SS1 via
FSoE, requires EtherCAT) safety module has been configured, the fieldbus variant cannot be changed.

§ Optimize DC-Sync: Cycle times
SC6, SI6: You can now optimize the synchronization of the nodes in your EtherCAT network, even when the controller
and drive controller have different cycle times (parameter: A287).

§ Referencing wizard: Referencing jerk
Parameter I44 Referencing jerk is now also displayed in the wizard (wizard: Referencing).

§ Motor wizard: Wake & Shake
Parameter B33 Wake & Shake dynamics for synchronous linear motors with relative motor encoder and commutation
via Hall sensor is now also displayed in the wizard (wizard: Motor).
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§ Lean motor: Weighting of the control coefficients
To simulate the behavior of an asynchronous motor, you can parameterize a reset time Ti of 0 ms for the velocity
controller for your Lean motor with sensorless vector control. For this case, optimizations were made to the operation
of the velocity-dependent factors for weighting the control coefficients (control mode: B20; reset time: C32; factors:
B146, B147).

§ Graphical programming: Read parameters & write parameters
For the blocks for reading and writing parameters, the parameter to be read or written is now also displayed for the
hits in the structure view in the Search tab. General optimizations were also made for the subsequent removal of
parameter coordinates to be read or written.

§ Graphical programming: Block name
The status bar of the graphical programming now shows you which block you are currently in for better orientation.

§ Graphical programming: Display block in library
You can now also display user blocks in the respective library via the Display block in library context menu.

§ Graphical programming: Context menus
General optimizations have been made to the context menus in the graphical programming with regard to the available
functions.

DriveControlSuite V 6.5-H SP1
This release is a product update and includes general optimizations.

DriveControlSuite V 6.5-H SP2
This release is a product update and includes general optimizations.

DriveControlSuite V 6.5-H SP3
This release is a product update and includes general optimizations.
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DriveControlSuite V 6.5-G
This release is a product update and includes general optimizations.

DriveControlSuite V 6.5-G SP1
This release is a product update and includes general optimizations.

DriveControlSuite V 6.5-G SP2
This release is a product update and includes general optimizations.

§ STOBER Predictive Maintenance
This service pack contains minor optimizations to STOBER Predictive Maintenance which mainly affect the load matrix.

• Load matrix: Precision
By expanding from 2 to 4 decimal places, the load matrix now shows you the calculated life performance of the
geared motor with higher precision.

• Load matrix: Gear ratio
The gear ratio is now taken into account when calculating the speeds for the load matrix.

• Load matrix: File name
For motors without an electronic nameplate, the file names for the load matrix on the SD card of the drive
controller are now generated from the checksum of B00[0] and B00[1]. This automatically detects that the motor
has been replaced and generates a new load matrix accordingly.

• Load matrix: Backup file
The storage behavior of the load matrix has been optimized so that the data is now also saved in a backup file and
can be restored at any time.

• Load matrix: Data structure
Through optimizations to the data structure, the load matrix is now clearer and requires less memory.
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DriveControlSuite V 6.5-F
As of this release, you can optimally plan the maintenance of your geared motors with Predictive Maintenance. The new
Backup & Restore convenience function allows you to save the configurations of your drive controllers with the help of the
EtherCAT master and to restore them in case of service for example. For PROFIdrive applications, application class 4 is now
also available and the new DS6 online help provides you with helpful information about DriveControlSuite.

§ Predictive Maintenance
Plan the maintenance of your geared motors proactively and at the optimal time with Predictive Maintenance. The
function is automatically active for STOBER geared motors with an electronic nameplate as of production date April 27,
2022, and can be activated manually for older geared motors or geared motors without an electronic nameplate.

• New wizard: Predictive Maintenance
A model-based analysis procedure is used to determine a life performance indicator for your geared motor. You
can use this to obtain a recommendation for replacing the geared motor and send it to your controller (parameter
R100, R101).

• Load matrix
The load matrix visualizes real load situations of the geared motor in the wizard and can be used as a basis for
optimizing the service life of the gear unit.

§ EtherCAT: Backup & Restore
EtherCAT master (TwinCAT 3): During initial commissioning or if drive controllers are replaced in case of service, you
can now automatically import previously saved configurations (backups) into the new STOBER drive controllers. The
new convenience function is available via the new STOBER_Backup_Restore function block as well as via new
commands in script mode.

§ PROFIdrive: Application class 4
SC6, SI6: From now on, PROFIdrive applications are also available in application class 4 for your projects, such as for
robotics and machine tool applications (AC4: telegram 3). More information on this can be found in the PROFIdrive
operating manual.

§ DS6 online help
The DS6 online help provides you with information about DriveControlSuite via the menu bar (Help menu > Help) or via
the keyboard shortcut [F1].

• DS6 program interface
Descriptions of the individual areas of the program interface and instructions for helpful functions make it easier
for you to operate DriveControlSuite.

• More about DriveControlSuite
Background knowledge of DriveControlSuite helps you understand basic concepts or processes such as the
connection setup or configuration.

• Tips and tricks for users
Learn how you can use a few simple steps to optimize your workflows and save time when creating and
maintaining your project.

More new features

§ EtherCAT: Diagnosis History
EtherCAT master (TwinCAT 3): You can now have the controller read out diagnostic messages from the EtherCAT
diagnostic memory of the drive controller when you add parameter A250 to the process data mapping.
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§ SSI encoder: Free setting
For SSI encoders at interface X4, the data length, an alarm bit, clock frequency and monoflop time can now be set
variably (data length: 8 – 32 bits; clock frequency: 100 – 1000 kHz; monoflop time: 10 – 100 µs). For SD6 drive
controllers, you can also use the new function at interface X120 (XI6 terminal module: as of hardware version 14; RI6
terminal module: as of hardware version 8). The new parameters are available in the wizards of the respective
interface (H00 = 78: SSI free setting, H14 - H17).

§ Scope: Acquisition details & comment function
In the Scope and Multi-axis scope windows, you can now view details about the scope image such as stored comments,
recording time, sampling time and pre-trigger in the lower margin area of the Scope images and Combinations tabs.
There are also 2 new icons here to show/hide the lower margin area and edit the comment of the selected scope
image.

Optimizations

§ Compare drive controllers
You can now also compare the process data mapping of different drive controllers. Accuracy has been increased for the
comparison of double-axis controllers and option modules.

§ Import parameter values
SC6, SI6: Parameter values can be imported even more reliably thanks to minor adjustments for Lean motors and
double-axis controllers.

§ Change configuration
As of the current firmware V 6.5-F, even minor changes to the project configuration and graphical programming result
in a changed configuration, e.g. if you change the designation or description of the drive controller or edit comments in
the graphical programming.

§ PROFIdrive: Read out encoder data
SC6, SI6: When establishing the PROFINET connection, you can now automatically read out the encoder data of the axis
if you select the Automatically accept encoder values at run time (online) option in the TIA Portal for the data exchange
of the technology object (communication object: Sensor format; DS6: M537; TIA Portal: PNU 979).

§ Motor wizard: Control mode 48, control mode 70
The Motor wizard has been revised for synchronous servo motors with a relative motor encoder and for synchronous
linear motors with a motor encoder with regard to the available parameters (control mode: B20).

§ Test phase wizard
The Test phases wizard now also enables commutation of linear motors with an absolute linear encoder via parameter
B07, in addition to commutation of linear motors with a relative linear encoder via parameter B05.

§ Wizards: Feedforward control
For mapping the feedforward control, the block diagrams and available parameters of the following wizards have been
revised: Motion core wizard, Position controller wizard and Velocity controller wizard.

§ Wizards: Virtual master
Using the Virtual master wizard, you can now set the preset position for the virtual master. The two control panels of
the virtual master now show you the cause if the virtual master cancels or denies a motion command (parameters:
G58, G163).

§ SS1: Brake ramp
Stopping the axis by SS1 has been optimized for the case that a brake ramp was already active using motion command
MC_Stop.

§ Graphical programming: Version management
Version management is now also available for user blocks.

§ Graphical programming: Read parameters, write parameters
There have been minor optimizations to the blocks for reading and writing parameters for use in double-axis
controllers and library blocks.
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§ Graphical programming: Process data mapping
Optimizations have been made for user-defined parameters with regard to process data mapping, such as for
transferring floating-point numbers with percentage scaling or for transferring accelerations, decelerations or jerks.

§ Graphical programming: Data types
The unified designations for the data types make it easier for you to orient yourself in the graphical programming.

§ Graphical programming: Decimal separators
Constants of the REAL data type (floating-point numbers) now support both periods and commas as decimal
separators.
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DriveControlSuite V 6.5-E
This release is a product update and includes general optimizations.

§ Lean motor: Double-axis controller
SC6, SI6: Lean motors operated on axis B of a double-axis controller now run more stably and are less susceptible to
faults, thanks to control mode optimizations.

§ PROFIdrive: Wizards
SC6, SI6: Minor optimizations to the wizards for applications with PROFIdrive make it easier for you to commission your
projects.
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DriveControlSuite V 6.5-D
Starting from this release, you can use the STO and SS1 safety functions via PROFIsafe as well as PROFIdrive type
applications in your drive projects for SC6 and SI6 drive controllers. In Drive Based Synchronous type applications, the
electronic cam disk is also available for synchronous operation in addition to the electronic gear unit. Using the drive
controller comparison, you get a quick overview of your projects and can optimize your control cascade with the new user
interface for the set value generator.

§ PROFIsafe
SC6, SI6: Use the STO and SS1 safety functions via the new SU6 safety module and PROFIsafe for your projects. The
new Calculate F_iPar-CRC: PROFIsafe and Monitoring: PROFIsafe wizards simplify commissioning and diagnosis. More
information on this can be found in the new SU6 safety module manual.

§ PROFIdrive
SC6, SI6: From now on, PROFIdrive type applications are available in application classes 1 and 3 for your projects (AC1:
telegrams 1, 2, 3; AC3: telegram 111). Benefit from a selection of technology objects, such as for synchronous
operation or cam disk applications. The new wizards are grouped under the Application PROFIdrive wizard. More
information on this can be found in the new PROFIdrive operating manual.

§ Electronic cam disk
In Drive Based Synchronous type applications, new functions for the electronic cam disk are now available.

• New movement commands
In the Control panel motion as well as the wizards for the Command and Motion block operating modes, there are
new motion commands for the electronic cam disk (MC_CamIn, MC_CamInAbsolute, MC_CamOut).

• Cam editor
In the cam editor, you find all functions that you need to create, edit, import and export cam profiles. You can open
the cam editor using the new Electronic cam disk or Cam profile wizards.

• New wizard: Cam profiles
The new Cam profile wizard offers you an overview of the cam profiles that you can create with the cam editor.

• New wizard: Electronic cam disk
The new Electronic cam disk wizard enables the creation of electronic cam disks. Here, you can define how the cam
disk is started and which curves follow the start curve in the positive or negative direction of motion.

§ Compare drive controllers
Compare drive controllers with each other for differences in project configuration, parameterization and graphical
programming.

• Project tree
Compare drive controllers within the same project or from different project with each other. To do so, select
Project tree > Drive controller > Context menu: Compare drive controllers.

• Online functions
Compare a drive controller in the project and a real drive controller with each other, e.g. before transferring the
configuration to the drive controller. To do this, use the new button in the Online functions window.

§ Scope: Set value generator
In the scope Direct image tab, there are new operating elements with which you can use the set value generator in
order to optimize the control cascade of your drive controllers.

More new features

§ Scope: Direct image
If you do not want to discard a direct image immediately, you can convert this to a scope image as needed and store it
in the project.
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§ Online connection
The Assignment and live firmware update window as well as the associated button in the project menu are now called
Online connection.

§ Direct connection: Redundant IP address
If drive controllers are in the same network with the same IP address, DriveControlSuite intercepts the addition of a
direct connection and outputs information in the Add connection dialog box.

§ Accurate search
The search function in wizards as well as the parameter list now also returns results if you search for elements from
array or record parameters.

§ EtherCAT: Parameter addressing
In the configuration dialog, you now have 2 options for projecting the receive process data (Rx) for EtherCAT.
Furthermore, you can influence the addressing of array and record parameters: If you project EtherCAT Rx, the first
element of the array or record parameters is addressed with subindex 0 hex. For EtherCAT Rx SDO Info, subindex 0 hex
supplies the subindex number of the last element of the array or record parameter.

§ EtherCAT: SDO Info
Using the SDO Info service, the EtherCAT controller can read out all objects defined in the object directory from the
drive controller if you have configured EtherCAT Rx SDO Info for the receive process data (Rx). You can define which
objects are transmitted using the service in DriveControlSuite (parameter A268).

§ EtherCAT: Diagnosis
In the wizard for EtherCAT diagnosis, you can now read off the AL status code as additional information (parameter
A257[3], EtherCAT wizard > Diagnostics).

§ Ethernet over EtherCAT: Connection setup via DHCP/DS6
If you use Ethernet over EtherCAT, you can now assign the IP addresses of the drive controllers automatically via DHCP
or DriveControlSuite when setting up the connection. You can read what you need to do for this in the EtherCAT
operating manual.

Optimizations

§ Scope: Binary representation
In the first activation of binary representation in the scope, there was an error in the display of the lines, which was
corrected.

§ Synchronous operation: Consumer correction
SD6: If you activate consumer correction for a slave axis (G183 = 1: Active) and then assign it to the master using the
Master-slave window, parameter G115 is used instead of G120 for the IGB motion bus mapping.

§ Ramps for torque/force build-up (MC_TorqueControl)
If you use the MC_TorqueControl motion command, you can make specifications for the build-up and reduction of
torque/force using the wizards. In Drive Based type applications, you will find parameters G500 and G501 in the Set
torque/force, velocity bracketing: Data source wizard. In CiA 402 type applications, you will find parameter A561 in the
Operating mode wizard.

§ Save reverse documentation
The creation of reverse documentation is now considered a change to the project, which now also allows you to save
reverse documentation if there otherwise have not been any changes to the project since last saving.

§ Scaling calculator: Translational axis model
In the scaling calculator, the conversion of the acceleration was optimized for translational axis models (Axis: Scaling
wizard).

§ Asynchronous motor: Position encoder as motor encoder
In asynchronous motors with vector control, you can now parameterize an external position encoder as a motor
encoder.
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§ Graphical programming: Read & write parameters in real time
Using the new Real time option in the properties of the Read parameter and Write parameter blocks, you can ensure
that the block can be accessed in real time. If real time access is not possible, there is an error in the structure check.

§ Graphical programming: Mark all blocks
You can now mark all blocks with [Ctrl] + [A], even if editing mode is not active, e.g. in order to copy all blocks to a
different project.
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DriveControlSuite V 6.5-C
This release is a product update and includes general optimizations.

§ Evaluation of HIPERFACE DSL encoder
SI6, SC6: We have optimized the evaluation of HIPERFACE DSL encoders: Evaluation now runs more stably and is less
prone to faults.
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DriveControlSuite V 6.5-B
This release lets you get to your destination faster and more securely: New context menus allow you to change between
different areas within DriveControlSuite quickly and direct images save you the trouble of clearing excess scope images.
The new parameters for building and reducing torque/force ensure more even movements and, in the IGB motion bus
network, you can now monitor your axes for synchronism.

§ Get there faster
New context menus allow you to change between the different areas within DS6 quickly: Jump from the messages or
parameter check right to the respective parameter or block, or quickly switch from the wizard to the parameter list and
vice versa.

• Jump from the parameter check right to the parameter in the parameter list or wizard (context menu: Show
parameter in parameter list or Search for parameter in wizard).

• Switch from the wizard to the parameter list and vice versa (context menu: Show parameter in parameter list or
Search for parameter in wizard).

• Switch from the parameter list right to the graphical programming for the block where the parameter was defined
(context menu: Show parameter block in graphic editor).

• Jump from the messages right to a block in the graphic editor (context menu: Show block in graphic editor).

• In the graphical programming, jump from the structure check right to a block in the graphic editor (context menu:
Show block in graphic editor).

§ Scope: Direct image
In scope, you can use the new Direct image tab now to create temporary scope images: The current scope image is not
saved permanently and the previous direct image is overwritten. As a result, you no longer have to clear excess scope
images when you only want to record something briefly.

§ Building torque/force
In Drive Based type applications, you can create more even axis movements now by setting specifications for building
and reducing set torque/force for the MC_TorqueControl motion command (parameter G500, G501).

§ Monitor synchronous operation
SD6: In Drive Based Synchronous type applications, you can now monitor the synchronism of your axes in the IGB
motion bus network independently of a controller: If a monitored axis is no longer synchronous with the master, the
master and all slave axes are stopped using a quick stop. In the Master/Slave window, you can activate monitoring and
select which axes are to be monitored.

More new features

§ Orientation by color code
In the project tree, you can now assign a color code to your drive controllers to maintain a better overview: The color
code is displayed in the project tree and in wizards, the parameter list, graphical programming and scope (context
menu: Color code).

§ Add connection: Type
In the Add connection dialog box, you now see the type of drive controllers in the network so that you can create more
purposeful connections.
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§ Additional functions wizard
The Additional functions wizard is now also available in CiA 402 type applications; it simplifies access to the additional
Establish torque/force with enable and action activation functions. Action activation is now available in Drive Based
type applications using the wizard, as is position conversion. In Drive Based Synchronous type applications, you can use
the wizard to activate other additional functions, such as the cam control unit and print mark evaluation for the
master.

§ New wizard: Master: Cam control unit
In Drive Based Synchronous type applications, the new Master: Cam control unit wizard helps you when parameterizing
an additional function.

§ New parameter: Master position resolution
Similar to parameter I160 (position encoder), there is a new parameter G103 (master encoder): The parameter shows
the number of position values per encoder increment. With a value < 1, the resolution of the encoder is lower than
that of the axis model. Rough quantization can cause problems in the position control, as not every displayable position
can be approached.

§ New parameter: SS1 deceleration
SD6 with SE6: The new parameter S36 Current deceleration shows you right in the drive controller which deceleration
is set for the emergency stop SS1 in the safety module.

§ Script mode: takeSnapShot
The new command for script mode creates reverse documentation for all drive controllers in the network defined in
the script and reads it into a new module. If no drive controllers are defined, the scripts tries to connect to all drive
controller in the network and create reverse documentation for them.

§ Graphical programming: New block
The new block 536 Round R32 with saturation rounds 32-bit floating-point numbers up or down to the nearest integers
(data type: REAL32 → INT32).

Optimizations

§ EnDat 3 encoder: Motor temperature sensor source
The source for the motor temperature sensor is always set for you by default, but now it can also be switched to an
alternative source as an option (parameter B35).

§ Accurate search
With minor adjustments, we improved the hit accuracy for desired search results in wizards and the parameter list.

§ Window and wizard title as tool tip
If your screen becomes cramped, you can now have the titles of windows and wizards displayed as a tool tip to
maintain an overview better.

§ Problem-free connection setup
SI6, SC6: Thanks to changes in IP address assignment, setting up a connection between DriveControlSuite and drive
controllers now also works smoothly in case of strict firewalls.

§ Increased user-friendliness
Functions such as saving and closing projects or libraries are now grayed out if you cannot use the function at the
moment (such as because no libraries are open).

§ Holding torque of the brake
The holding torque for the next brake release process is now limited to 70% of the maximum output current of the
power unit (parameter F103).

§ Live firmware update: Add new firmware version
Instead of several individual firmware files, there is now just a single file for each firmware version that contains the
firmware for all series and fieldbus variants.
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DriveControlSuite V 6.5-A
This release focuses on performance: Numerous adjustments increase the performance ability of DriveControlSuite
significantly and shorten click paths to support more convenient and efficient operation. Starting from V 6.5-A, the DS6 also
supports One Cable Solutions with an EnDat 3 encoder for SI6 and SC6 drive controllers.

§ One Cable Solution with EnDat 3 encoder
SI6, SC6: Now, you can also project and commission your projects with a One Cable Solution with EnDat 3 encoder.

§ Improved performance
The improved performance is most noticeable in the following functions:

• Projects are saved and loaded much faster.

• Modules are copied in the project tree faster.

• Parameter values from external projects are imported faster.

§ Visualized performance
The new progress display in the status bar visualizes the improved performance, such as when loading projects or
updating project configurations.

§ Shortened click paths
You now need fewer clicks to reach your goal with these functions:

• Update project configurations
Update project configurations for your drive controller without detours in the project tree using the new function,
located in the context menu on the drive controller, module or project level.

• Clean up project
Clean unnecessary scope images, reverse documentation or variable parameter lists out of your project right in the
project tree. The function is available in the context menu on the drive controller, module and project levels.

• Manage scope images
In the scope image overview, you can delete all scope images using two new buttons or close all open images with
just one click.

More new features

§ Convenience functions for Script mode
Adjust default settings for Script mode for how read or write access to the drive controller is to be enabled for your
project. The Preset connections dialog box for settings can be opened using the context menu in the project tree on
the project level.

• Carry out firmware updates with the help of the default settings.

• Update the system parameters, device control and applications using the default settings.

§ New wizard: Optimize DC-Sync
SI6, SC6: Check and optimize the synchronization of nodes in your EtherCAT network using the new wizard.

§ Assignment by PLC device name
In your EtherCAT network, you can now assign the projected drive controllers using the device names given to the
actual drive controllers by the controller.

§ Confirm reference
After an encoder fault, you no longer have to reference referenced axes again. Instead, you can simply confirm the
actual position as referenced and continue operation.

§ Extended cam control unit
SI6, SC6: The additional Extended cams function is now also available for SI6 and SC6 drive controllers.
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§ Synchronous servo motor control mode for incremental encoders
Synchronous servo motors can now be projected with relative encoders (incremental encoders), even for endless travel
ranges.

§ Synchronous operation: Producer source
In the Drive Based Synchronous application, the unreferenced actual and set positions are now available for
synchronous operation.

§ Torque/force build-up with enable
The default for G90 Establish torque/force with enable has changed: With the power unit enabled, control is no longer
inactive by default. Instead, position control (standstill) is active to prevent any gravity-loaded axes from lowering. A
new velocity control selection (standstill) has been added.

§ New wizard: Option code
Here, all parameters for CiA 402 applications can be found in the context of the Option code.

§ Graphical programming: Write parameter
Using the 300006 Parameter Write block, you can now write individual array elements and axis-specific parameters in
global program areas.

Optimizations

§ Electronic gear unit nameplate
The evaluation of the electronic gear unit nameplate and the mapping of data on the axis model parameters have been
optimized (parameters B28, B30).

§ Process data mapping for EtherCAT and PROFINET
The following points were optimized for EtherCAT and PROFINET:

• In case of firmware changes, your changes to the process data mapping remain in place.

• For double-axis controllers, the process data mapping is now displayed more clearly, with each axis next to each
other.

§ Positioning up to the stop with excess
Movements when positioning up to the stop with excess are now even more consistent.

§ Lean-Motor: Switching position modes
SC6: Position modes can now be switched reliably even in highly dynamic acceleration processes at the torque/force
limit.
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DriveControlSuite V 6.4-F
This release is a product update and includes general optimizations.

§ Ethernet over PROFINET
SI6, SC6: You can now use Ethernet over PROFINET at the service interface.
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DriveControlSuite V 6.4-E
This release includes a few new functions for scope and two new additional functions. From now on, you can use the new
wizard for master/slave scaling when configuring synchronous operation.

§ Scope
These new features make the diagnostic tool even more helpful for you:

• Apply channel scaling
You can now transmit the channel scaling of an existing scope image to other images. To do so, use the new button
in the scaling area.

• Automatic serial recording
After completing one scope image, automatically start the next recording. To do so, set parameter T26 to value 3.

• Comment function
The new symbol lets you immediately see in the overview which scope images have comments stored. You can
display the comment as a tool tip.

§ New additional functions
You can expect these additional functions starting from V 6.4-E:

• Extended cam control unit
Even more functions for cams are now available in Drive Based applications, such as: multiple cams, time cams,
multi-cycle cams and cams with a time stamp for digital outputs. Activate the extended cam control unit using the
Additional functions wizard.

• Action activation
The new additional function lets you start even more actions over fieldbus or digital inputs, such as: testing phases,
calibrating the motor, optimizing the current controller and testing the winding. Activate the new Action activation:
Control/status word wizard and the associated parameters using A76.

§ New wizard: Master/slave scaling
SD6: In Drive Based Synchronous applications, the new wizard creates the IGB motion bus mapping for you and helps
ensure that the master and slave axes are compatible with regard to the following settings: travel range, revolution
length, unit of measure, decimal places. You can reach the wizard using the new button in the IGB assignment dialog.

More new features

§ New shortcuts
These new shortcuts make it easier to work with DS6:

• [ALT] + [P]: Open/close project tree and project menu

• [ALT] + [M]: Open/close messages

• [ALT] + [E]: Open/close parameter check

• [ALT] + [V]: Open/close variable parameter lists

§ User-defined settings
Configure settings for the display of scope images and select standard directories to load, open, save, export and
import files. To do so, select the menu bar > Settings > Settings.

§ Wizards: Display and hide sidebars
Easily hide or display the list of wizard pages and parameter descriptions as needed using the new buttons in the
wizard menu bar.
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§ New import functions
These new import functions make work with DS6 even more efficient:

• Import drive controllers
Import entire drive controllers from other projects. To do so, select > Module > Context menu: Import drive
controllers in the project tree.

• Import parameter values by axis
Apply parameter values for your axis either from a drive controller in the current project, from a drive controller
from a different project or from a text file that contains the desired parameter values. To do so, select > Drive
controller > Context menu: Import parameter values in the project tree. When importing from projects, the
parameters are applied regardless of the access level or visibility; when importing from a text file, the access level is
taken into account.

§ Display project overview
The new project overview gives you the most important information about the projected drive controllers at a glance:
device type, option modules, firmware, transmit and receive process data, device control, application and user-specific
programs. Select Project> Context menu: Display project overview in the project tree and export the overview as HTML
if needed.

§ Display change overview
If you have made changes in the configuration dialog, a change overview is displayed after clicking on OK. You can
export the change overview as HTML using the respective button or save the column of previous values as a text file
and reimport them if you are not satisfied with the changes.

§ Delete reverse documentation
You can now discard all reverse documentation within a module. Select > Module > Context menu: Delete reverse
documentation in the project tree.

§ CiA 402 application
There are the following new features for CiA 402 applications:

• Direction-dependent torque/force limiting (A315, A316).

• Velocity override
For drive-based Profile position and Profile velocity operating modes (A340).

• Automatic run to the reference position
Moves to Home offset at the end of referencing (I43).

• Direction of motion for absolute positioning with endless travel range
For the drive-based Profile position operating mode (A621, bit 6 – 7)

§ Support for 8-pole resolvers
In addition to 2-, 4- and 6-pole resolvers, you can now also use 8-pole resolvers.

§ Digital and analog inputs and outputs
You will now find the digital and analog inputs and outputs under new designations: BE, BA become DI, DO; AE, AA
become AI, AO.

§ Event 50: Safety module: New cause
SI6, SC6: For event 50: Safety module, there is a new cause (cause 16): The drive controller is interrupted if an STO is
requested with the power unit active.

§ Switching the fieldbus variant: EtherCAT <> PROFINET
SI6, SC6: You can switch the fieldbus variant in the assignment dialog. To do so, select Change fieldbus under the drive
controller. Always inform STOBER Service via email in case of a switch. This ensures that a replacement will be
delivered with the right fieldbus variant in later Service cases. For a change from EtherCAT to PROFINET, the booter
version must be at least V 6.4-B (see parameter E52[5]).

§ EtherCAT: Cycle times 250 µs and 500 µs
EtherCAT can now be used with a cycle time of 250 µs or 500 µs.
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Optimizations

§ Offline display of static information
Starting from firmware V 6.4-E, you can also have values of the following parameters displayed offline without reverse
documentation: B01, B03, E52, E54, E56, E58, E61, E122, E123, H09, H129, H149, R00 – R129.

§ Graphical programming: User adjustments
You can now save your adjustments for the graphical programming in a memory area specially designed for this
purpose. Adjustments in this memory area are independent of changes in the configuration dialog, such as an update
to a newer version of the firmware. We recommend moving your adjustments from the memory area for the
application to the new memory area for user-specific adjustments ([CTRL] + [X], [CTRL] + [V]).
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DriveControlSuite V 6.4-D
In this release, the new variable parameter list function and the new wizard for nameplate data conveniently gives you the
information at a glance. The new features of the Online connection window are especially useful in larger projects with
many drive controllers.

§ New function: Variable parameter list
The new function allows you to compile the parameters currently required for a quick overview in individual parameter
lists (Menu bar > View > Variable parameter list).

§ New wizard: Nameplate data 
In the new Nameplate data wizard, you can now view the data of the electronic nameplate at a glance.

§ Online functions
These new features can be found in the Online functions window:

• Restart/save all drive controllers
You can now restart all drive controllers at the same time and save values for all drive controllers at the same time.
The Save values (A00) and Restart (A09) actions can be found in the Actions for drive controllers in online operation
area in the Online functions window.

• Hardware check
During assignment, this checks whether the projected hardware matches the actual drive controller. Unsuitable
configurations are not transmitted; instead, DS6 issues a warning about the discrepancy.

More new features

§ Network adapter with IPv6
You can now also use network adapters with IPv6 support; communication still takes place using IPv4.

§ Fault 52: Communication: New cause
SI6, SC6: The new cause 15 indicates that the EtherCAT fieldbus variant was projected but the firmware for PROFINET is
installed in the drive controller, or vice versa.

§ Phasing to absolute set position
The additional Phasing function in the Drive Based Synchronous application has been supplemented with the
MC_MoveAbsolute motion command.

Optimizations

§ Jog step as single step
A jog step request is only applied when the axis is at a standstill. Adding multiple successive jog steps is no longer
supported.

§ Fault 56: Overspeed: Source
Fault 56: Overspeed is triggered by changed sources less frequently. The fault is now triggered based on the filtered
velocities E15 and I88.

§ Quick stop in case of communication failure
SI6, SC6 with SY6: In case of an EtherCAT communication failure with FSoE, the axis will now come to a stop even more
quickly (event 52: Communication, cause 6: EtherCAT PDO timeout). A formula for calculating the quick stop duration
can be found in the SY6 safety technology manual.

§ Continue after SS1/SS2
SD6 with SE6: Using the Continue function, you can now also continue motion commands that were interrupted by SS1
or SS2 safety functions.
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§ Lean motor: Improved performance
The control mode for Lean motors now enables a higher maximum controller gain and improved radial runout or
constant speed at low speeds. Furthermore, the recovery time for load jumps has been shortened and positioning
accuracy as well as repeat accuracy of the position has been increased.

§ Continue function: Torque/force build-up with enable
In Drive Based applications, the Continue function and the Torque/force build-up with enable function (G90) are now
independent of each other: A canceled motion command can now also be continued when using G90.
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DriveControlSuite V 6.4-C
This release is a product update and includes general optimizations.

§ Overheat protection
SI6, SC6: Thanks to even more accurate i2t models, the drive controller is now protected even more reliably against
thermal overload.
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DriveControlSuite V 6.4-B
This release is a product update and includes general optimizations.

§ Booting of SD card
SI6, SC6: When booting using the SD card, the drive controllers are now ready to operate even more quickly.

§ Evaluation of resolvers
SI6, SC6: Undervoltages occur less frequently when evaluating resolvers.
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DriveControlSuite V 6.4-A
This release also makes multi-axis scope available for SD6 drive controllers. Starting from V 6.4-A, buffered subsequent
motion blocks enable smoother movements without stopping.

§ Multi-axis scope
SD6: The multi-axis scope is now also available for the SD6 drive controller.

§ Buffered subsequent motion blocks
In Drive Based applications, you can now smoothly transition to the subsequent motion block in motion block
operating mode during positioning commands without stopping. Define the final velocity at which the set position is to
be reached in motion block A using parameter J18 and specify the subsequent motion block B in J286 so that it is
preloaded (buffered) for a smooth transition. In motion block B, you use J21 to specify that it is to be executed as a
subsequent motion block at the end of motion block A, without any trigger.

Optimizations

§ Extended reference retaining 
If the encoder cables are swapped, the reference is now automatically restored once the cables have been correctly
assigned again and the control unit has been restarted. If, for example, the encoder cables of a double-axis controller
were swapped during the removal and reconstruction of a system, the reference will now be retained.

§ Control panel in case of fault 
If a drive controller is interrupted, an active control panel now also indicates this.
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DriveControlSuite V 6.3-F
In this release, there are a plethora of new wizards that make commissioning your drive projects easier. The assignment
dialog has also been revamped, with new functions for you in the context of firmware.

§ New wizards
These new wizards are available in DriveControlSuite:

• Test and bed in brakes 
The new Test brake and Bend in brake wizards have control panel functionality and are adapted for operating the
SD6 drive controller with the SE6 safety module.

• Position measurement 
The additional position measurement function now has a wizard of the same name. As a counterpart to the Touch
probe function in CiA 402 applications, the additional Position measurement function is available starting from V
6.3-C for Drive Based applications (parameters: J110 – J115).

• Virtual master 
There are two new wizards for the virtual master: Command operating mode: Virtual master and Virtual master
velocity override: Data source.

• Phasing 
For the additional Phasing function, there is a new wizard in command operating mode: Command operating
mode: Phasing.

§ Assignment dialog
You can expect these new features in the assignment dialog with V 6.3-F:

• Buttons instead of context menus
The context menu functions are now available as buttons.

• Queue for connection setup
When setting up a connection, a new symbol on the drive controller indicates whether it is waiting in the queue for
transmission. You can also use the symbol to remove the respective drive controller from the queue.

• Firmware check during connection setup
When setting up a connection, the projected firmware version and the firmware version in the drive controller are
compared with each other. If the firmware version in the drive controller is not sufficient for the project, the
connection is not set up.

• Firmware update for multiple drive controllers
The new convenience function makes it possible to perform a firmware update for multiple drive controllers
simultaneously. The function is located in the assignment dialog in the new Firmware update tab.

More new features

§ Nameplate information
In addition to B and F parameters, the information on the electronic nameplate is now mapped on the new R
parameters R40 – R54. As a result, you can trace deviations between the original nameplate data that may arise
through optimization.

§ Graphical programming: New blocks
For graphical programming, four new standard blocks are available with a variable input number and variable data
type: blocks 300009 Collector and 300010 Splitter (type converter) and blocks 300007 Min and 300008 Max
(selections).
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Optimizations

§ Higher accuracy within the position window
If the axis is moved manually with the power unit switched off, the set position I96 is updated to the actual position I80
– now also within the position window I22. As a result, there are no following errors nor any unintended compensation
movements when switching on the power unit: the axis moves with increased accuracy.
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DriveControlSuite V 6.3-E
This release gives you new functions and content for asynchronous and Lean motors.

§ Emergency braking for Lean motors
SI6, SC6: Like emergency braking in synchronous servo motors, emergency braking is now also available for Lean
motors in case of corresponding events.

§ IE3 asynchronous motors
In the configuration dialog, the motor data is now available for all STOBER asynchronous motors with energy efficiency
class 3.

Optimizations

§ Overheat protection
SI6, SC6: At a standstill and at low speeds, the drive controller is now protected even more reliably from thermal
overload.
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DriveControlSuite V 6.3-D
This release is a product update and includes general optimizations.

§ Evaluation of HIPERFACE DSL encoder
SI6, SC6: We have optimized the evaluation of HIPERFACE DSL encoders: Evaluation now runs more stably and is less
prone to faults.
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DriveControlSuite V 6.3-C
This release help you find what you are looking for: The new search and many more new features get you to your goal
faster.

§ New search function
The new search function helps you in the parameter list, in wizards and in the current graphical programming level.
Simply enter the parameter coordinates or names into the search field.

§ Move drive controller between modules
Using the new context menu in the project tree, you can now move drive controllers between modules.

§ Jog control panel: Set reference
You can now also set the reference easily using Jog control panel.

More new features

§ Direction of motion for each motion block
During absolute positioning with infinite axes, you now have the option to specify the direction of motion for each
motion block (parameters: C243, J33).

§ Cam control unit for the master position
In the Drive Based Synchronous application, the additional cam control unit function is now also available for the
master: The new Master: Cam control unit wizard and new parameters G510 – G514 are displayed when the additional
function is active.

§ Graphical programming: Data types for Read parameters block
Parameter values are output from the 300005 Parameter Read block now according to their data type; for binary
output, this is automatically as BOOL. Output as INT32 or REAL32 is optional.

§ Graphical programming: Block input with constant
You can now connect a block input with a block for reading or writing constants directly via the context menu.

§ Graphical programming: Parameter values in real time
The abbreviation RT (Real Time) in the block name tells you whether the block supplies the parameter value in real
time.

Optimizations

§ Overheat protection
SI6: During operation at maximum output current, the drive controller is now protected even more reliably from
thermal overload.
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DriveControlSuite V 6.3-B
This release is a product update and includes general optimizations.
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DriveControlSuite V 6.3-A
Starting from this release, the new SC6 drive controller is available together with the Lean motor in DriveControlSuite. The
SD6 drive controller also benefits here. Using the new SE6 safety module along with PASmotion configuration software,
you can commission your axes reliably.

§ SC6 drive controller
The new SC6 drive controller can be selected in the configuration dialog.

§ Lean motor
SI6, SC6: The new Lean motor control mode can be selected in the configuration dialog.

§ SE6 safety module with PASmotion
SD6: The new SE6 safety module can be selected in the configuration dialog. To project the safety module, simply start
PASmotion via the project menu.

More new features

§ New applications: CiA 402 and CiA 402 HiRes Motion
The new applications replace the previous CiA 402 Controller Based, CiA 402 Controller Based HiRes Motion and CiA
402 Drive Based applications. The new applications contain both the controller-based and drive-based operating
modes, which you can switch between at a standstill. The old applications are still supported by DS6, but are no longer
available for new project configurations.

§ Frequency analysis for scope images
You can now apply a frequency analysis to scope images. The function can be found in scope in the new Frequency
analysis tab.

§ Disconnect all connections
The new convenience function allows you to disconnect the connection of DS6 to all drive controllers in the module
with a single click. The function can be found in the context menu of the Online connection window.

§ Reliable referencing to zero pulse
I37 shows you how much distance was traveled after a referencing event during the search for the zero pulse. If the
distance moved is very small and the zero pulse is very close to a reference switch, you can increase the reliability of
the reference position by shifting the start of the search with I53.

§ Reset limit switch memory automatically
If the power unit has not yet been enabled since the power unit was switched on, the limit switch memory is reset
again as soon as the signals are correctly transmitted to the limit switch. This means that a fault is triggered if the drive
controller is ready to operate faster than the limit switch or controller, even though the limit switch memory is
automatically reset.

§ Arrange windows
Using the new function in the Window menu, you can arrange the windows for wizards, the parameter list and scope,
for example, stacked or next to each other in the workspace.

Optimizations

§ Activation/deactivation delay X1
SD6: A43 is now also used for the deactivation and activation delay.

§ Velocity override for jog via fieldbus
In Drive Based and Drive Based Synchronous applications, the velocity override G466 now also works for jog via control
word. Jog via operating unit and control panels remains unaffected by G466.

§ Expansion of the fault memory
SI6: The fault memory was expanded from 20 to 50 entries.
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§ Clean EtherCAT mapping
The new function in the EtherCAT wizard lets you delete modules you no longer use from an ESI file.

§ Graphical programming: Read/write parameters
The new versions of the 300005 Parameter Read and 300006 Parameter Write blocks can now also read and write in
the data type of the parameter. Conversion to INT32 or REAL32 is still optional.
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